
>> Welcome to Closing The Gap Solutions.

This webinar Supporting remote learning with

free Microsoft tools was sponsored by Microsoft and was recorded in May 12th,
2020.

It was presented by Rachel Burger.

Rachel is a Learning Disabilities AT consultant for Microsoft Education.

>> Thanks for having me.

I'm so glad to be able to present to you today.

I know that there's so much information

out there currently during our time of remote learning,

and so I thank you for choosing to spend your time with me for the next 60 minutes.

Couple of things about me.

I am all in when it comes to

learning differences and supporting students who learn differently.

First and foremost, I am the Assistive Technology Specialist at Microsoft Education.

I wear a hat in the area specifically of Dyslexia.

I am also the Executive Director of a Minneapolis based non-profit that

works on behalf of students with dyslexia, dysgraphia, and dyscalculia.

Then, among other things,

I am a mother of three sons,

two of which have their fair share of learning differences.

Today when we are going through presentation,

some of the examples you'll see will be from my sons are other children that I work
with.

Hopefully, examples will also help you to look at things

with another lens or provide specific examples that you can work from.

Let's go ahead and get started.

What I'm going to do is,



we're going to be spending the beginning couple minutes in PowerPoint.

I'm going to give you a backdrop as to,

how these tools came to be and how Microsoft became involved in the education
area.

Then I'm going to escape out and we're going to spend

a lot of our time in what I call demo lands,

demonstrating specifically within the apps.

I'd like to be very purposeful about calling out what I'm doing,

because I know as an individual who learns differently myself,

that it's helpful to know what someone's doing or where they're going,

otherwise it seems a bit like a magic show.

We are going to encourage you to type in your questions at anytime,

but there are going to be two specific time periods,

and when I answer those.

One is going to be on our break between when we're

finished up the reading tools and right before we move into writing tools.

Then I will also save time at the end for questions as well.

Let's go ahead and get started today.

I'm starting out with a slide that has a lot of meaning to me.

This is an image of equality versus equity.

Many of us have seen this before.

It circulates around, those of us in the education community.

It's that image of individuals who are trying to see over a fence to see a baseball
game.

There's a common misconception that,

equity and equality mean the same thing and that they can be used
interchangeably,

especially when talking about education.



But the truth is,

they don't and they can't.

The two words are similar,

but the difference between them is crucial,

especially when considering students who learn differently.

Equity is encouraging access to the same opportunities specific to the need.

We can see on the right-hand side here in this image,

we've got students with varying degrees of support.

Before we can get to that place of enjoying equality,

we have to ensure equity.

Today, my presentation is about showing you how with

Microsoft learning tools we can provide students

with equitable access to their curriculum.

We can help them engage in their learning environment.

We can help them personalize their experience.

Then ultimately, the end goal is ensuring that they gain independence.

How we became involved a little bit more heavily into

inclusive technology and in the education space at Microsoft is,

some of the data points, and some of the things today that are different

about classrooms than say when you and I were in the classroom.

Scholastic put out a survey back in 2014.

A little over 14,000 educators responded and gave

us some really clear data on what it's like in the classroom today.

Three-quarters of all educators report working in

classrooms where students reading levels span four or more grade levels.

Three-quarters of educators reporting,

that three-quarters over their classrooms have special education students within



them.

That can be a student on an IEP,

a student on a 504,

or a student with some unique level of need that requires accommodation or
modification.

Half of all of our classrooms today,

educators are reporting, they have students who are not native speakers.

Just those three data points help illustrate why

up to 50 percent of instructional time can

be lost managing needs including Assistive Technology.

There's a lot going on within that gen ed classroom

today that makes it a really difficult in my mind.

It really get difficult task to ensure equity and equality.

Moving along here, when it comes to inclusive technology,

Microsoft likes to think about these three categories.

The first is students of all abilities and wanting to make sure they're able to do

their best work and personalize their experience in a way that works best for them.

Next is our educators,

and really wanting to enable them to engage

every single learner by providing accessible tools for the classroom.

Then third, on a school level,

Equity and Inclusion are something that are

definitely top of mine and wanting to ensure that

we can meet this needs of students and empower them to reach their full potential.

From an accessibility standpoint,

about a billion people globally require some level of Assistive Technology.

Assistive Technology benefits everyone,



including people with permanent disabilities,

like some other ones listed in this slide here,

to individuals with temporary impairments like a broken arm

or a situational requirement like, working hands free.

Disability, as many of come in many forms,

both visible and invisible.

Today we're going to talk about

the cognitive area and the Learning Disabilities that fall into that category,

and how when you are designing inclusively,

it helps all people, not just those with specific impairments.

I also want to make a point about Microsoft in the education space.

The Newish CEO, Satya Nadella is really and a key part of Microsoft's mission,

which is to empower every person on the planet to achieve more.

If you think about that,

they're not saying 50 percent of

the population or 75 percent of

the population are only those who are neurotypical learners,

they're saying every single person.

Inclusion is really a core part of

Microsoft's message and they're building that into core products and across
platforms.

You're going to see them continue to focus on inclusive technologies

well beyond what I'm going to demonstrate for you here today.

One more slide here before we go and demonstrate within the apps.

Along that backdrop is where Microsoft started the work in inclusive technology.

The last thing here I want to share with you is

the global Hackathon that which Immersive Reader came to be.



Every year, anyone in the company can work with

anyone they like on any technology they like for one week.

In 2015, Reading FOBT,

accessibility and education experts came together to look at the latest science,

research and technology techniques, specifically on Dyslexia.

The reason being for that is that,

such a significant percentage of our population struggles with printed word,

whether they've got dyslexia,

and whether they're diagnosed with it or not.

impacting someone's ability to read printed word is,

as you can imagine, pretty significant.

They built some things into an add-in, into OneNote.

They won the Hackathon that year.

Then they went on to work with teachers and students focused in that area and they

discovered that not only their capabilities that they built in to help reading,

help those students who struggled with reading,

but also helped students who had dysgraphia,

non-native speakers, ADHD, emerging readers,

and so really many more beyond that initial intention.

Now, I'm going to escape out of

our PowerPoint and I'm going to go ahead and go into OneNote.

I'm down here my toolbar,

OneNote is a desktop application,

and it's also a free online application.

The online application, most individuals who are using a Mac,

a Chromebook, or an iPad,

would probably benefit from using the free online version and anyone can access



that.

That's another thing I want to point out too again,

anyone can have an online access account to OneNote.

OneNote is a digital notebook, if you will.

You see I've got off to the left here different subject matters.

Then within each of those,

I've got further information.

How you get content into OneNote is really important.

I'm going to spend a minute here.

You use the insert tab and then we go to file.

What that does is, it pulls up information from your personal device.

I like to turn that off because it's like showing someone my closet,

which is likely not very organized.

Once you go to insert,

and then file, it pulls from your computer,

and you're looking to have a Word document or PDF in this case,

so that you can inserted into the OneNote notebook.

Imagine, and again, think about right now and we independently

You want to make things more accessible for students who struggle with reading,

and so doing that within

a OneNote notebook or some of the other ways that I'm going to show you in just a
moment,

greatly help reduce the strain that student is experiencing.

Here, I've got a third grade student who diagnosed with

dyslexia and reading only at a early first grade level,

His educators putting things into OneNote notebook.

Then what he does is goes to the view tab,



clicks on "Immersive Reader",

and now here's where the magic starts.

So we've got the capability with that "Play" button down here to have text to speech.

>> The Closet Creature by Kelly Hashway. Bump! Bump!

>> You'll probably hear that being read aloud.

It might not be totally loud right now but I know you guys can hear it to some
degree.

Over here, we've got our voice speed and our voice selection.

What I love about this is again,

in the same manner that publishers often say they assume,

but our content is put out as if we all prefer to read in the same manner,

black text on white paper,

a certain size font,

a certain level of spacing.

Here with our voice speed,

we can change that because students who are listening

to content auditorily often have a different speed that they prefer.

Some of them can process that really fast,

others, not so much.

Those are the tools you can utilize,

and then up here to the right,

we have our text preferences.

So let's bump up that text sizing.

Here, we can increase our spacing, and often times,

my own son tell me he needs the spacing because without it,

it said the plows through the comment and then he

does the time he gets to the end of the page.



In his words, spacing tells his brain to slow down.

We have font choices here.

Something that looks very handwritten or you can go with the typewritten.

We have background colors, again,

a white background.

Some people like to do it in this manner and actually,

when it comes [inaudible 00:13:11] for me, but [inaudible 00:13:19].

So whether it [inaudible 00:13:25] insufficiency,

which a small percentage of the population struggles with when reading,

or low vision, or a simple preference,

options at your fingertips.

You don't have to prove it for proving a need.

Right here, built-in.

So let's go over our options here

sounds the same.

[BACKGROUND] So does [inaudible 00:14:03].

We can highlight our parts of nouns,

adjectives, and we'll give the adverbs that little love here too.

Notice that we can change the color that it's highlighted up.

So that's the [inaudible 00:14:20] with that background color.

Maybe the educator in particular [inaudible 00:14:25] things students

highlight [inaudible 00:14:27] up as well.

Neat tool here.

[OVERLAPPING] I'm moving on so that

[inaudible 00:14:38] distraction for me and maybe for you as well.

Under our last reading [inaudible 00:14:45] this mode.

But we're like [inaudible 00:14:54] little



so that we were amount of content at one time.

Well, that's what line focus mode is.

We can choose one line, three line,

[inaudible 00:15:12] think about if you're someone who's struggling,

you could break it into crank up

that text sizing and have this highlighting just a couple of words at a time.

So all sorts of uses there.

A number of you guys are familiar with Boardmaker.

Boardmaker has partnered with Microsoft to make the picture dictionary possible.

Boardmaker makes the visual images for

individuals who have speech and communication disorders,

and now they're embedding those into content here in the immersive reader.

I absolutely love having Boardmaker a part of this,

and it's super fun because whenever we click on things,

we have more words,

more is being added all the time.

So we can get the photograph to help create meaning or comprehend,

and then we can also have the speaker read it aloud too.

Then lastly, last spring,

we added an update and put translator into Immersive Reader as well.

I have a dropdown here of anywhere up to

65 different languages and I can choose to change just a word or the entire
documents.

I think about my non-native speakers

or even their parents when

it comes to parent communication with individuals that are not speaking English,

you can utilize the translator.



So now my documents translated a Spanish. Let's have a listen.

[BACKGROUND] Oops, sorry about that.

[BACKGROUND] What's even more

fun is that Picture Dictionary follows in that language.

Then we can also toggle between the

original and the Spanish version using these two tabs at the top.

Pretty amazing, I think.

Just built-in right there,

free, accessible to anyone.

You don't have to go outside and use a different app, it's built in.

This is OneNote notebook.

Here's me clicking back to show you where in OneNote notebook, again,

there's a desktop version which I am using,

and that's for anyone who was in Windows devices.

Windows devices can use the online version as well.

But if you're using a Mac or a Chromebook or iPad,

you might want to utilize the free online version.

Oftentimes, right about now,

I get a question. That's great.

I haven't used OneNote before,

are there are other places we can use this?

The answer is yes.

So let's go ahead and we're going to go to Edge browser.

If you can see me and my toolbar here and this arrow,

I am looking for Edge browser.

Edge is Microsoft's Internet search engine, if you will.

So let's go back down to my toolbar.



You'll notice I have Google.

I'm guilty as charged,

I use both of them, and then I have Edge as well.

I'm going to show you why you may want to make Edge as

your primary search engine or ensure that your students have access to this right
now,

again, during this period where we're doing a lot of independent learning.

Again, students who s0truggled to read during this time period of independent
learning,

there's really heavy on the reading.

Even my son say fatigue quite easily.

They'll do all the other tasks they can do that don't require a lot

of difficulty or strain before

they get to the reading just because they're trying to conserve.

So if we use Edge browser to do research or other things,

what we can do is,

you'll notice right up here in my bar here,

there's the Immersive Reader icon.

So when I click on that,

I'm going to get a scan that pops over top of the page just

similarly to what we experienced in OneNote.

Now you can see,

if I move my cursor,

I get a toolbar that pops down.

Another thing, you've probably realized,

we have all of the ads wiped out.

So again, we're getting that Reading View reduces distractions.

So I have my read aloud button,



I have my text preferences built-in here where I can add my text spacing,

change my background color,

and increase or decrease my text sizing.

I also have the reading preferences which allow me line focus mode,

and I have grammar tools,

the syllable edification and the parts of speech and showing labels.

We don't yet have Picture Dictionary,

but that's something that's coming very soon and that's something where I

just was doing some of the Beta testing for last week and it's going to be amazing.

So again, all of this right here,

built into Edge browser.

This is a mainstream Internet search.

It's just a website that I think has a lot of wonderful content

for students from K12 and also for educators.

So any topic you might be researching here,

whether it's animals, food and health, entertainment,

etc., and then it [inaudible 00:20:56] levels content as you can see,

and then we can use the Immersive Reader.

So again, Edge browser,

any mainstream Internet search you're doing,

you have the ability to use Immersive Reader or the read aloud feature.

One more thing I want to show you before we

move out of just talking about Edge browser is

that third-party apps and publishers are rapidly starting to add Immersive Reader.

What that looks like is I'm clicking on Flipgrid here.

You can see the Immersive Reader icon here on the page.

When we go back into the PowerPoint,



I'll show you all of the other publishers and apps that are adding Immersive Reader,

but Flipgrid and others are adding Immersive Reader as a cognitive service.

Whenever you see that icon on their websites,

you can click on it and have that Immersive Reader experience.

One other place that Immersive Reader is built-in and available to you is also in
Word.

I'm currently in Word Online,

this is again the free online version,

you can use it when you are using a Chromebook,

a MAC, an iPad,

you can use it with Windows devices as well.

Similarly to the View tab in OneNote,

I'm going to click on the View tab.

We're going to click on the Immersive Reader icon.

Now I'm getting that skin pop over top of the page.

Here I can just go ahead and have that text to speech and do my ear reading.

>> [inaudible 00:22:53] >> All of my ability to

adjust how I'd like to consume that content is up here on the right,

just like it was with one note and within the Edge browser, okay?

We're going to go back in our PowerPoint for just a couple minutes,

and then we'll stop before we get to writing.

I'm going to show you a video,

oftentimes, people will say these are all wonderful,

but how else can we get content into OneNote notebook or utilize Immersive
Reader?

With that, we're looking at Office Lens.

What office lens just did was snap a photograph of a book.

Now it's utilizing Immersive Reader right then and there on the device.



[NOISE] Let's just show that again really quickly.

Take a photograph of a text running OCR utilizing Immersive Reader.

Notice you can also use OneDrive, OneNote, or Word.

You can send things to those categories as well.

When you're using the Immersive Reader,

right then and there,

it's assuming you're wanting

that Immersive Reader experience right there on that device that you're using.

Office Lens is something that works with an iPad,

an iPhone, or an Android device.

It's free in the App Store as a download.

Off to the right here again,

this is the icon for Office Lens,

this is what it looks like when you download it.

Now this next video I have up is

another thing you can do with Office Lens that I think is really important,

especially again, during any time when

we're talking about students who have learning differences.

But in particular right now,

it's very helpful to my sons who have

been getting packets sent to them from their school.

Let's take a watch here.

We're snapping a photograph of a worksheet packet.

Now we are going up here to get a text box and then were dictating in that text box.

When we're done dictating answer,

we move the textbox to the appropriate location.

Notice here I can choose a different color for my textbox,



dictating the answers again,

then we're going to move that text box.

Now notice we can enlarge or shrink the text box,

you do that with a pinch of finger motion.

From here you can send

the completed worksheet to your educator with a click of a button by using the e-
mail.

What we're doing is we're snapping a picture of that worksheet,

turning into a photograph,

overlaying textbox onto the photograph and

making a new photograph to then send to the educator.

This is a work around that my kids use because they both have dysgraphia and

writing into tiny textboxes has always been a great difficulty for them.

When you have things like this,

it's not entirely big enough for my children to write into and even this spacing,

so this is their work

around and something that I would highly recommend trying and checking out.

Again, Microsoft Office Lens, it's free,

available in the App Store for a download on your iPad, iPhone, or Android.

Let's move to our next text here or next slide.

This is a special education class.

The lady in the blue cardigan is [LAUGHTER] Lauren Pittman.

She is a Microsoft Innovative Educator and a good friend of mine.

She was an early adapter of Immersive Reader in

her special education class and she saw some really amazing growth for her
students.

I want to share a little bit of that with you.

Again, she was integrating this as a tool,



it wasn't taking place of an intervention and it

wasn't taking place of class instruction.

It's an integrated tool.

Well, I'll just show you one of the lot of growth,

but I'll just show you one of the students in particular and

you guys have access to the slides so you'll be able to look through these on your
own.

I know we're on a certain amount of time here today.

Again, student number 4 IEP Early Goal to get to 60 correct words and minutes.

The end result was 90 words a minute achieved.

They surpassed the IEP goal of 30 words a minute before the end of the school year,

which is really, really amazing.

Again, utilizing Immersive Reader as an integrated tool within the classroom to
support,

to reteach and something that they can do at home as well.

There is a research study with RTI on the benefits of Immersive Reader at this link
here.

It's 30-pages deep dive,

but the shortened version is that fourth graders,

sixth to eighth graders and tenth to 12th graders were studied

during a six weeks period utilizing Immersive Reader.

They had a lot of amazing growth,

10 full percentage points,

reading comprehension got better,

writing improved, and non-cognitive processes as well.

Here's a wonderful quote from an educator in Argentina,

"I just wanted to let you know that a mom spoke with me,

and started crying her son was



finally able to read on his own thanks to the Immersive Reader.

Currently changing lives of many students."

I know personally the students that I work in advocacy with,

and my own kids are seeing tremendous support and gain from utilizing Immersive
Reader.

I can't speak highly enough about it.

Also, a study with the British Dyslexia Association on the Knowl Hill School found that

16 out 18 children showed improved behavior and

11 out of 16 showed their comprehension get better.

A little bit more information there.

Merging readers, as I mentioned before,

tend to benefit as well.

Then I want to let you know that for those of you that add

quizzes or texts during this time of online learning,

but also when we're back in our regular classrooms,

Immersive Reader is built into Microsoft Forms,

you can build your quiz or your text and

then Immersive Readers right there to enable the student to be able to

independently have that text read aloud to them and still access the content there.

It might be something to check out.

Here are apps and publishers that have added Immersive Reader as a cognitive
service,

we've got many and this is updating itself pretty quickly because as you know,

I clicked on Flipgrid.

We also have Pear Deck and Kidblog as well.

Chances are some of your favorites might already have Immersive Reader added in.

This is all about Immersive Reader page,

something that you can take a look at as you're learning how to utilize it.



One more thing I want to share with you before we close out

our reading, Dyslexia Awareness Curriculum.

This is something that's done in conjunction with

a global charity based out of the UK called Made by Dyslexia.

They've created two training modules that anyone can take at

anytime for free in the Microsoft Educator Community.

Just some basic information about what dyslexia is and how to

support it and why we want to support students who have dyslexia.

Again, at this link fully available to you and I highly encourage it.

This completes my segment on reading,

and I am more than happy to take some questions

right now for just a couple of minutes before

we move on to writing and [inaudible 00:31:38].

I'm going to open up the questions here see what we can find.

[NOISE] No.

>> Becky says the audio was cutting in and out.

Let me see if I can plug something else here. I'm so sorry.

>> No that Rachel that was earlier, it's good now.

>> Okay. I'm just going to plug in this additional speaker. I'm sorry.

I should let you text me or something.

I mean, I'm using a different speaker now,

external speaker and maybe that's a better idea so that we

can have consistency. How does it sound?

>>It sounds good.

>> Okay. Do we have any questions?

>> See the question panel,

otherwise, I can read them to you.



>> So don't rely can't see them. It's really odd.

>> It's good questions and you can pop it out into its own little.

>> Here we go ahead to pop it out.

I'm sorry, my speech was breaking up, guys.

I know this is being recorded.

If you want to re-watch the first couple of minutes,

I know that Becky will probably share that with you guys.

Okay. Share it.

Dictate into the textbox.

So you must have been talking about office lens?

Yes. You use a dictation feature on your device to dictate into the text box.

Then when you're done with that,

you just move the textbox.

Can you have the text in the worksheet read you share and yes,

definitely can have it read to you utilizing immersive reader.

May get OneNote does not work on Chrome books.

It does if you're IT enables you to utilize OneNote and the online version of it.

But usually you have to have your schools IT allow that.

Okay.

Understand someone says to you, understand correctly,

Immersive Reader only available on certain websites.

No edge browser is the Internet search engine and then if you're using that browser,

you have Immersive Reader embedded in.

Whatever website you go to,

you should click on the Immersive Reader button menu upper

corner and then will read that webpage.

It may not read a Wikipedia page,



but I haven't tried it yet in the new edge browser.

Okay, it looks like that's all the questions we have for right now.

Let's go ahead and get back into more contents.

We'll talk about writing and math and

maybe I'll share a couple extra tips if I have time.

Please again type questions in as you have them and let's just keep rolling here.

What I have up currently is what we affectionately

call the periodic chart of learning tools availability.

This will tell you what features you're going to get across,

what types of devices, et cetera ,

or applications. All right?

This is something you'll want to reference in the PowerPoints

for yourself or at the loony tools flyer.

As we're moving into writing here,

we're going to start out with a photograph of children working

on a writing project and looks like they're not too happy.

Pretty frequently when a child struggles with reading,

they also struggle with writing and so again,

the Headmaster of the Knowl Hill School is saying

their pupils without exception hate writing.

But learning tools transformed their pupils and so as I frequently do,

because I didn't have a photograph of my son when he

was working on the writing assignment I'm going to show you,

I use my kid's examples frequently and discuss

how these tools benefit them because as you can imagine,

I try everything out on them.

This is an example of my son's writing assignment from language arts.



In on the left here is a handwritten examples.

You can see that a struggles deeply with the manual task of writing.

What happens for him is obviously the manual task is difficult.

But then also when you're having difficulty with a manual task and you're dyslexic,

in this graphic, you know, spelling, punctuation,

all of those things that have to be added in while you're writing

start to impact the ability for you to sequence information,

to add context, to richness of content,

all of those variety of things.

That's where you end up with in the middle getting really

big and at the end rating the end really big because it takes so much time.

This example on the left took 50 minutes of class time.

Yet, as educator will tell me and in deed in this time,

I know what he wants to say because I can sit down and have

a verbal conversation with him and we'll paint me

a beautiful picture just doesn't come out that way on paper.

At home, we tried out the new dictation and editor software and

this example on the right is what he came up

with and only took him 12 minutes start to finish.

Big difference and even bigger differences that obviously it's legible.

But if you look at the detail of the sentences,

that's some pretty amazing detail, pretty rich content.

I mean, he really paints a picture.

You can really see it as something that's not that evident in the handwritten
example.

I'm going to show you how all of that is possible,

rather than looking at spelling.



At slides, I'm going to show you how it was possible by escaping out a PowerPoint.

We're going go to desktop.

But you'll remember though,

that these tools are available both in Word desktop and in Word

online and dictation is also

something that's available in OneNote as well. Just something to know.

Let's start out here with the dictation feature

that again enabled my son to be able more effectively do what

we call a brain download and this is where we're just

getting the content out onto paper and so over,

you've got your home tab here and all the way over to the right.

Built-in, we have dictation.

I can start quickly and easily dictating the content

that I have in my head onto paper simply by clicking a button and talking, period.

Here I'm highlighting where I just dictated.

I will say I am a user of dictation software.

I have been for some time.

I used to jokingly say that I was a donor because I couldn't

find a software that worked effectively for me.

I wanted something that worked like my iPhone.

Today I have it right here Built in for free.

So I'm no longer a donor,

dictation button right here.

You'll notice that if I click on this tiny little arrow,

I can change the language I'm dictating it.

That's really important as well.

Alright. Dictating was that tool



that enabled my center more effectively and he didn't have to train it.

He just simply started talking and really beautiful ability

to pick it up and keep time with how quickly he's talking.

In addition to that,

quite often students benefit from having that content read aloud

and so I'm under the Review tab here and going all the way over Read Aloud button.

I'm just going to click Read Aloud and this is exactly what it sounds like.

It's a read aloud tool,

just going to read it back.

This isn't the Immersive Reader.

just going to tell me what I wrote.

>> Start quickly and easily dictating the content that I have in my head-on chip.

>> Okay. So we can hear that it's reading aloud after the radio.

I've got skip the ahead,

skip back, pause and play.

I've also got my reading speed and voice selection.

Okay, so some simple things that I can do.

Again, going back to how to my son create

that content quickly and efficiently within 12 minutes.

It was Dictation and then having it read aloud.

Then he could go in and add a little bit more content if you wanted to using

that Read Aloud and so those are the two main features.

What I'm also going to share,

is the tools in the Editor pane that enabled him

to be able to edit his document all by himself independently,

which is not something he was able to do before.

Again, under the Review tab,



we're all the way to the left and we see editor

and I'm also going to go under the Home tab and over by dictation you see editor as
well.

You might have it in one or both places.

When I click on editor,

a pane pops up on the right hand side here and it tells

me I've got the various different suggestions within these categories.

We've got spelling in grammar, we've got clarity,

conciseness, formality, punctuation, and vocabulary.

Okay? So we can start over with the spelling errors and I can say,

oh wow, I've got seven spelling errors.

Let's go ahead and get started there.

What's really amazing here is that previously in Word and other tools,

you'd have a drop-down list.

If you misspell a word, you're going to get a drop-down list and it's like,

which version did I mean of that word?

You don't get any sort of context.

It's really hard to be able to determine

which version of the Word you met and you go to pull out your thesaurus

so login into another panel to do a search on the versions of the word and read it.

Now we've got some contexts built-in to help disambiguate between

the versions of the words that you might have met and off to the right here,

if you're fatiguing, you can have that read aloud.

>> Similar to experts.

>>Okay. So quickly and easily enabling you to correct those

spelling error and if I want to just toggle through all of my spelling errors,

I'm going to use this arrow to get me there.



Otherwise, when you correct it,

it'll automatically advance you.

If I don't want to work on my spelling errors anymore or it's giving me suggestions,

maybe I'm meant to spell it that way.

I'm going to arrow out and I'm going to click on the next area I'd like to go to.

Maybe I want to go to grammar and now what I like about this is that it's telling me

the version of the word I want affect versus saying utilize effect versus effect.

But then if I click on the arrow,

it's going to give me a little bit more information as to why.

Okay? So Editor pane again enables you to just simply advance through that
document.

And more independently, correct and edit your own document.

Okay, one more thing that enables users to be able to more

effectively create content is Word Prediction.

That's what it's called.

I was losing my words out.

You'll see it's popping up for me here on the screen,

and so that's something that you can turn on when utilizing words.

Let me show you how you do that.

I can go down to my toolbar here.

Really, I want to go into my settings,

then I want to go typing, typing settings.

Now, my computer is pulling up my typing settings for me.

You'll notice that these are grouped here.

On the left-hand side,

these are grouped by different things here,

so printer and scanner,



mouse, touchpad, or typing.

Of course I typed, typing in,

and I want to go into my typing settings, and I want to change that.

So I'm going to scroll all the way down here.

I don't need help with me spelling.

What I'm looking for is my hardware keyboard,

and you'll notice as I get to hardware keyboard,

I have turned on show text suggestions as I type.

I could also have auto-corrector and etc.

There's a number of things you can do under this, but in this case,

you are looking for show texts suggestions as I type.

That's another feature built-in right there for you to utilize.

Then one more thing I want to make sure to show you, because again,

50 percent of our classrooms have students who are non-native speakers.

Again, under the review tab,

I have translator built-in right here,

and so if I need to translate my documents,

a section of it or the entire document,

I have the translator pin that pops up over here.

We have a choice of languages and I can translate my document

to be easier for someone else to consume content.

Drop down list of languages,

and then if I was to click Translate, it would translate it.

Don't forget we've got that read aloud,

so once it's translated,

someone can have it read aloud.

[NOISE] Then we do also have immersive reader built-in to word desktops,



so under the view tab,

just the same as OneNote notebook,

order online, you have view tab, and immersive reader.

Now, where desktop is the only place that immersive reader does look different.

So our features pop up in this ribbon.

It looks a little bit different than it does in the others,

but you still have that same functionality.

With the remaining time,

I'm going to show you the math tools because I know these are also very helpful
again,

considering our current status,

which is remote learning.

I want to make sure you get to check these out.

I'm going to go back to OneNote notebook,

and that's down here.

OneNote notebook again, it's a desktop for me,

but it can be the online version for someone else.

That's that digital notebook I have.

I'm going to go to Math,

so I'm clicking on Math Development.

In this case, I've already got an equation I've entered.

What I'm going to do is go to the draw tab,

and I'm going to use my stylus that I have to circle.

Stylus, and I'm going to circle my equation.

You could circle it, if you're using a touchscreen with your finger,

or even with your cursor.

At any rate, you're going to highlight that equation and then go to the math tab
here.



Now, you'll see that you have a math pin popping up on the right,

and a list of relevant actions.

In this case, I am going to solve for x,

and it's great to have the answer.

However, what I need is the steps

because I need to understand the order of operation to solve the equation.

Now, you'll get the steps to solving the equation and learn how to do the equation.

But also, you'll notice this immersive reader button.

So we can click on immersive reader.

Again, if I'm [inaudible 00:48:03] ,

I need to have this read aloud to me,

I can use my immersive reader,

or maybe I'm an individual who is

a non-native speaker and I need to have this read aloud in a different language.

Whatever the reason or maybe it's just a preference,

it's built-in right there.

That's one tool you can use in OneNote for math.

Then another I'd like to highlight is our graphing tool.

Let me move my toolbar,

I go to meeting out of the way.

Here's a handwritten equation.

Again, I need to circle this equation in order to access

our math pin and so I'm circling it,

and clicking on "Math".

I've got my relevant actions.

You'll also notice I could ink to Math,

so maybe my handwriting's not clear enough,



I could choose to ink to Math.

If it's not picking my handwriting up appropriately,

I could click on "Fix" and circle the part of the equation that needs to be fixed.

In my case, everything's just fine,

and I'm going to select my action,

which is to graph in 2D.

Now, I have an interactive graph that pops up.

Anywhere I'm hovering, it's giving me coordinates.

I could choose to utilize these key graph features,

so what I can do there is I can show the zeros,

I can show the y-intercept on the graph.

You'll see right up here,

I have those on the graph for me,

and then I could insert this on the page.

I'm going to close out of the graphic.

I'm going to show you one more thing,

and then we're going to get to questions.

Inking replay is something that I love

as an individual who works with both my children and other kids.

Sometimes, students who learn differently,

maybe they've got dyscalculia, as I do,

and it might be harder for them to understand

the order of operations or remember that sequence,

and so they benefit from reteaching.

In this case, what we can do is we can click on the "view" tab and the "Replay"
button,

and we can have the equation or the operations of the equation replayed.



Again, think about an educator moving through the,

how do we solve this equation?

Or think about on the flip side of it, a student,

maybe the educator wants to see how that student solved the equation.

Here is a tool built into the OneNote that enables you to utilize that.

I think it's really amusing.

I'm just going to show it to you again really quickly because it is so easy.

We're under the view tab.

We click on "Replay",

we select the content we want replayed, and away we go.

Okay guys, I am at the place in which I could answer some questions.

Becky, if you would read those aloud to me,

I'm going to pop up some of the slides that I'd like to

address as we wrap up that have links that are built in for you guys.

>> Sure. First question was,

what Word version are you're using?

I'm using 2016, and I don't see the options you are showing.

>> I'm using 2016,

and you should see them.

There's a couple of different things that can impact that.

It's whether you are on a school issued laptop,

and they have not enabled you to utilize those tools.

Also what impacts that is whether or not you've updated your device anytime
recently.

I would check those two things firstly,

and then maybe just

switch over to utilizing the online version because it's always updated.



You don't have to worry about updating it yourself. Next question.

>> Let's see.

Someone was wondering if this was being recorded and if it can be viewed again.

Yes, we are recording it.

It will just take us a day or so to process it,

and then we'll get it up on our website for anyone for watch again.

>> Awesome, and thank you for that, Becky.

Because I know guys oftentimes,

when you're learning something new and I'm moving at a pace that I know it's brisk,

but I've seen people talk much faster than me,

so I feel like I'm trying to do a good job.

But the point is when we are learning something new,

it's always beneficial to go back and re-watch.

One, we'll have the video for you to re-watch,

but also what I have queued up here on the screen is also very helpful.

These are called interactive trainings.

They're broken into reading,

math, writing, and communication.

Basically, everything I showed you here today,

outside of communication, we would need a little bit more time for that.

These are interactive click-through guides that you

can take in the comfort of your own home and again,

breaking apart the different pieces.

Maybe you really only want to focus on math,

or reading or writing.

So you could do it at your own pace.

It's click through, and you're clicking on everything.



So it's again, helping you to learn because you're actually actively involved,

so check those out.

I'm going to show you.

There was these links in the slide deck, the interactive training,

and then here is further training and professional development materials.

I know you guys are getting a ton of

information right now during this time of remote learning.

Again, these are here as a resource.

You don't have to feel like you're overwhelmed by content,

use it as you needed it.

It's just here as a resource.

My last slide was a quote. I could've used that.

[LAUGHTER] I may have grabbed the wrong deck, but anyway,

what I wanted to say is accessibility isn't something that we should have to ask for.

It should just be there built-in,

and something that we're considering when we're developing content and materials,

we need to insure access for all.

It also shouldn't be a members only club for those who can pay,

and so that's why I'm passionate about the tools that I'm sharing with you

today because they truly are available to everyone.

Just again, please reach out with any questions.

You have my email in the slide deck,

so if you're having questions or even if you have

experience that you'd like to share with me

where a child has had a really positive experience,

we would love to hear those things too.


